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Complete teacher’s manual for Open office impress 2 Class 1 

Impress 2 Class 1 యొక్క పూర్తి టీచర్ manual. 
 Summaries 

Class 1 సార్ాాంశాం 

 What is ‘Standard toolbar’? 

 ‘Standard toolbar’ అంటే ఏమిట?ి 

 Why we use ‘Standard toolbar’? 

 మనము ‘Standard toolbar’ ని ఎందుకు ఉపయోగిస్తా ము? 

 How to take a new slide by using ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఉపయోగించి కొతా్ slide ని ఎలా ప ందాలి? 

 How to open any file with the help of ‘Standard toolbar’? 

 ‘Standard toolbar’ సహాయంతో ఏద ైనా file ని ఎలా open చేయాలి? 

 How to convert text document file into a PDF file? 

 Text document file ని PDF file గత ఎలా మార్తాలి?  
 How to insert a table with help of ‘Standard toolbar? 

 ‘Standard toolbar సహాయంతో table ని ఎలా ఇనసర్్ట చేయాలి?  
 Why we use ‘Fontwork’ option?  

 మనము‘Fontwork’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to hide and unhide ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 How to hide and unhide ‘Line and filling toolbar’?  

 ‘Line and filling toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
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1. To stop video time at 01 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 14 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell how to type in a blank slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని blank slide లో ఎలా టైప్ చేయాలో 

వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

2. To stop video time at 01 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 34 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask how to insert a new slide and how many methods are 

there to insert a new slide’? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని new slide ని ఇనస ర్ట ్

చేయమనండి.మరియు new slide ని ఇనస ర్ట ్చేయటానికి ఎనిి  పద్దతులు 

ఉని్న యి? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

3. To stop video time at 02 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask which option is used for animation? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని animation  చేయటానికి ఏ option 

ని ఉపయోగిసాార్థ? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

4. To stop video time at 02 minute 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask what should we do to copy an object in different 

colors? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ object ని వివిధ colors లో copy 

చేయటానికి మనము ఏమి చేయాలి? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

5. To stop video time at 03 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to open ‘Impress file’. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ ని open 

చేయమనండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

6. To stop video time at 04 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert five slides and ask them to type 

something in the first slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఐదు slide లని ఇనస ర్ట ్చేసి  

మొద్టి సలయిడ్ లో ఏదైన్న టైప్ చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

7. To stop video time at 05 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to draw any shape on 2 and 3 slides and also 

ask them to do formatting on these shapes and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని రండవ మరియు మూడవ slide 

లలో ఏదైన్న shape ని గీయమనండి .మరియు ఈ shape లలో formatting 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

8. To stop video time at 05 minutes 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert any object with help of ‘Gallery’ 

option and in the 5
th
 slide draw their name with help of ‘Fontwork’ option and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Gallery’ option  సహాయంతో 

ఏదైన్న object ని ఇనస ర్ట ్చేసి ఐద్వ సలయిడ్ లో ‘Fontwork’ option 

సహాయంతో వాళ్ు  ప్లర్థని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

9. To stop video time at 05 minutes 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students if they’ve done all these five things in impress 

file and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  impress file లో  ఈ ఐదు 

పనులనిి టినీ చేశారా అని అడగండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

10. To stop video time at 06 minutes 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert 5 slides as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఐదు slide లని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

11. To stop video time at 07 minutes 58 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to type the given paragraph as shown in the 

video and also ask if they can type about themselves, then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఇచిి న ప్లరాని టైప్ చేయమనండి మరియు వాళ్ళు  వాళ్ు  గురించి టైప్ 

చేయగలరా?అని అడగండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

12. To stop video time at 08 minutes 17 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 17 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to select the blank slide as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

blank slide ని సెలెక్ట ్ చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

13. To stop video time at 08 minutes 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw any shape as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న shape ని  గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

 

14. To stop video time at 09 minutes 53 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 53 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the formatting on the image as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

image లో formatting ని చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 
15. To stop video time at 10 minutes 35 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 10 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw another shape as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

మర౉క్ shape ని  గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

16. To stop video time at 11 minutes 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the formatting on the image again as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

image లో మర౉క్సారి formatting ని  చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
 

17. To stop video time at 12 minutes 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert any picture with help of ‘Gallery’ 

option and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Gallery’ option  సహాయంతో ఏదైన్న పకి్ ర్ట ని ఇనస ర్ట ్ చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

18. To stop video time at 13 minutes 59seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the master pages on the 4

th
 slide as 

shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

న్నలుగవ slide లో master page లని అప్ల ల  చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

19. To stop video time at 15 minutes 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask the students to write their name with help of 

‘Fontwork’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Fontwork’  సహాయంతో వాళ్ు  ప్లర్థని టైప్  చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

20. To stop video time at 15 minutes 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask them if they remember what is ‘Standard toolbar’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Standard toolbar’ అంటే ఏమిటో 

వాళ్ు కి గురా్థంద్య? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

21. To stop video time at 16 minutes 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask them, there are how many methods to take a new 

‘Impress file’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొత ా‘Impress file’ ని తీసుకోవటానికి 

ఎనిి  పద్దతులు ఉని్న యి? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

22. To stop video time at 17 minutes 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know which shortcut command will you need to 

use to bring up a new slide. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొత ాslide ని తీసుకురావటానికి ఏ 

shortcut command ని ఉపయోగించాలో వాళ్ు కి తెలుసా? అని అడగండి. 
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23. To stop video time at 18 minutes 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to take a new file by the first method as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

మొద్టి పద్దతిలో  కొత ాfile ని తీసుకోమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

24. To stop video time at 19 minutes 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to take a new file by the second method as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

రండవ పద్దతిలో  కొత ాfile ని తీసుకోమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

25. To stop video time at 19 minutes 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to take a new file by the third method as 

shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

మూడవ పద్దతిలో  కొత ా file ని తీసుకోమనండి. 

Now just check whether they have completed the task or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు file ని తీసుకువచాి రొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 
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26. To stop video time at 20 minutes 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask which shortcut command will be used to open ‘Impress 

file’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ ని open చేయటానికి 

ఏ shortcut command ని ఉపయోగిసాార్థ? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

27. To stop video time at 20 minutes 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can open ‘Impress file’ with help of ‘Standard 

toolbar’? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Standard toolbar’ సహాయంతో 

వాళ్ళు  ‘Impress file’ ని open చేయగలరా? అని అడగండి. 

 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

28. To stop video time at 21 minutes 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to close their current file and ask them to open 

impress file again as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

వాళ్ళు  ప్పసాుతం ఉపయోగిసాుని  file ని close చేసి impress file ని 

మర౉క్సారి open చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

29. To stop video time at 21 minutes 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

30. To stop video time at 22 minutes 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to open their file with help of ‘Open’ option as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

‘Open’ option  సహాయంతో వాళ్ు  file ని open చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

31. To stop video time at 23 minutes 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to click on the ‘Document as email’ option as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

‘Document as email’ option  ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

32. To stop video time at 23 minutes 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘Send’ option as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

‘Send’ option  ని ఉపయోగించమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

Note: - tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

నోట్:విద్యా ర్థులకి ‘Send’ button ని కి లక్ట చేయవలసిన అవసరం లేద్ని 

చెపప మనండి. ఎందుక్ంటే email ని పంపంచటానికి internet connection 

కావాలి.  

33. To stop video time at 24 minutes 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 

 

Stop video here and ask, if they know why we use ‘Export as PDF’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Export as PDF’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

 

34. To stop video time at 25 minutes 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to convert their file into pdf format as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

వాళ్ు  file ని pdf format లోకి మారి మనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

35. To stop video time at 26 minutes 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and check whether they have converted their file into PDF or 

not and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,ఇప్పప డు విద్యా ర్థులు file ని PDF లోకి మారాి రొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

36. To stop video time at 26 minutes 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to see the video and understand how to use 

‘Print directly’ option and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో చూసి ‘Print directly’ 

option ని ఎలా ఉపయోగించాలో తెలుసుకోమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

Note: - printer machine should be connected with the system for printing so 

there is no need to click on the ‘Print directly option’. 
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నోట్: print చేయటానికి printer క్ంప్యా టర్ట తో క్నెక్ట ్అయుా ండాలి. 

అప్పప డు ‘Print directly option’ ని కి లక్ట చేయవలసిన అవసరం లేదు.   

 

 

 

 

 

 

 

 

37. To stop video time at 27 minutes 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students if they can use ‘Copy’, ‘Cut’ and ‘Paste’ 

option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  ‘Copy’, ‘Cut’ మరియు 

‘Paste’ option లని ఉపయోగించగలరా? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

38. To stop video time at 28 minutes 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

39. To stop video time at 29 minutes 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used copy, cut and paste option or not and 

then play the video. 

ఇప్పప డు విద్యా ర్థులు copy, cut మరియు paste option లని ఉపయోగించారొ 

లేదో  చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

40. To stop video time at 29 minutes 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask why we use ‘Format paintbrush’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Format paintbrush’ 

option ని ఎందుకు ఉపయోగిసాాము?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

41. To stop video time at 29 minutes 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

఑క్ object ని గీయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

42. To stop video time at 30 minutes 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

43. To stop video time at 31 minutes 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Format paintbrush’ option or not and 

then play the video. 

ఇప్పప డు విద్యా ర్థులు ‘Format paintbrush’ option లని ఉపయోగించారొ 

లేదో  చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

44. To stop video time at 31 minutes 57 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 57 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students if they can use ‘Undo and Redo’ option? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  ‘Undo మరియు Redo’ 

option లని ఉపయోగించగలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

45. To stop video time at 32 minutes 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 32 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to remove the object by using ‘Undo’ option as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియో లో చూపంచిన విధముగా 

Undo’ option  ని ఉపయోగించి object ని తొలగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

46. To stop video time at 33 minutes 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to bring back that object with help of ‘Redo’ 

which they had removed and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Redo’ option  ని ఉపయోగించి ఆ 

object ని వెనుక్కి తీసుకురమమ నండి..తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

47. To stop video time at 34 minutes 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 34 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Undo and Redo’ option or not and then 

play the video. 

ఇప్పప డు విద్యా ర్థులు ‘Undo మరియు Redo’ option లని ఉపయోగించారొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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48. To stop video time at 35 minutes 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students, if they know what we will do to give the link 

of another document on slide. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని slide లో మర౉క్ document కి లింక్ట 

ఇవవ టానికి మనము ఏమి చేసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

49. To stop video time at 35 minutes 59 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
50. To stop video time at 37 minutes 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 37 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Hyperlink’ option or not and then play 

the video. 
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ఇప్పప డు విద్యా ర్థులు ‘Hyperlink’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

51. To stop video time at 38 minutes 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they will be able to draw a table? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  table ని గీయగలరా? అని 

అడగండి. 

 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

52. To stop video time at 38 minutes 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to take a new slide as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ కొత ాslide ని తీసుకోమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

53. To stop video time at 38 minutes 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and students to click on ‘Table’ option as shown in the video 

and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Table’ option ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

54. To stop video time at 39 minutes 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 39 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have drawn ‘Table ‘or not and then play the video. 

ఇప్పప డు విద్యా ర్థులు ‘Table ‘ని గీశారొ లేదో చెక్ట చేసి తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

 

55. To stop video time at 39 minutes 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 39 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask what is ‘Display grid’ option? 



   

25 
 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Display grid’ option అంటే 

ఏమిటి?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

56. To stop video time at 40 minutes 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to show and hide ‘Grid lines’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Grid lines’ ని క్నిపంచేటట్లల మరియు hide  చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

 

 

 

57. To stop video time at 40 minutes 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can hide and unhide ‘Standard toolbar’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  ‘Standard toolbar’ option  

ని hide మరియు unhide చేయగలరా?అని అడగండి.   

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

58. To stop video time at 42 minutes 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 42 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to hide ‘Standard toolbar option as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Standard toolbar option ని hide  చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

59. To stop video time at 43 minutes 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 43 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to show ‘Standard toolbar’ option as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Standard toolbar option ని క్నిపంచేటట్లల చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

60. To stop video time at 43 minutes 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 43 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to hide ‘Line and filling’ option as shown in 

the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Line and filling’ option ని hide చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

61. To stop video time at 45 minutes 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 45 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to unhide ‘Line and filling’ option as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Line and filling’ option ని unhide చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

62. To stop video time at 45 minutes 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 45 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to close their file and shout down the 

computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 2 

Impress 2 Class 2 యొక్క పూర్తి టీచర్ manual. 
Summaries 

Class 2 సార్ాాంశాం 

 

 What is ‘Standard toolbar’? 

 ‘Standard toolbar’ అంటే ఏమిట?ి 

 Why we use ‘Standard toolbar’? 

 మనము ‘Standard toolbar’ ని ఎందుకు ఉపయోగిస్తా ము? 

 How to take a new slide by using ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఉపయోగించి కొతా్ slide ని ఎలా ప ందాలి? 

 How to open any file with help of ‘Standard toolbar’? 

 ‘Standard toolbar’ సహాయంతో ఏద ైనా file ని ఎలా open చేయాలి? 

 How to convert text document file into a PDF file? 

 Text document file ని PDF file గత ఎలా మార్తాలి?  
 How to insert a table with help of ‘Standard toolbar? 

 ‘Standard toolbar సహాయంతో table ని ఎలా ఇనసర్్ట చేయాలి?  
 Why we use ‘Fontwork’ option?  

 మనము‘Fontwork’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to hide and unhide ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 How to hide and unhide ‘Line and filling toolbar’?  

 ‘Line and filling toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
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63. To stop video time at 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask why we ‘Standard toolbar? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము Standard toolbar ని 

ఎందుకు ఉపయోగిసాాము?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

64. To stop video time at 01 minute 12 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 12 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask how to hide and show standard toolbar? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Standard toolbar ని hide మరియు 

క్నిపంచేటట్లల ఎలా చేయాలి? అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

65. To stop video time at 1 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they know what is ‘Display Grid’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Display Grid’ అంటే ఏమిటో 

వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
66. To stop video time at 2 minute 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Chart’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Chart’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

67. To stop video time at 2 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask do you know what is ‘Print file directly’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Print file directly’ అంటే ఏమిటో 

వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

68. To stop video time at 2 minute 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ ని open 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

69. To stop video time at 2 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to type the given paragraph on the first slide 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇచిి న ప్లరాని మొద్టి slide లో 

టైప్ చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

70. To stop video time at 3 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do formatting on the given paragraph and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇచిి న ప్లరాలో formatting 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

71. To stop video time at 3 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and check whether they have finished the typing or not and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులు టైప్ చేయటం ప్యరి ాచేశారొ లేదో 

చెక్ట చేయండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

72. To stop video time at 3 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to change the ‘Font style’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  వీడియోలో చూపంచిన విధముగా 

‘Font style’ ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

73. To stop video time at 4 minute 58 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 04 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the font size of the paragraph as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  వీడియోలో చూపంచిన విధముగా 

font size ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

74. To stop video time at 5 minute 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do ‘Bold’ and ‘Underline’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Bold’ మరియు ‘Underline’ చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

75. To stop video time at 6 minute 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the ‘Font color’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  వీడియోలో చూపంచిన విధముగా 

‘Font color’ ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

76. To stop video time at 6 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply ‘Bullets’ on the line as shown in the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

లైన్ లో ‘Bullets’ ని అప్ల ల చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

Now just check whether they have changed the formatting of paragraph or not 

and then play the video again. 

ఇప్పప డు విద్యా ర్థులు ప్లరా యొక్క  formatting ని మారాి రొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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77. To stop video time at 7 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask if they can tell there are how many methods to insert a 

new slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొత ాslide ని ఇనస ర్ట ్చేయటానికి 

ఎనిి  పద్దతులు ఉని్న యో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

78. To stop video time at 7 minute 52 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 52 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw a rectangle and also ask to change the 

formatting of the rectangle and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ దీర ఘచతురప్సంని గీసి ద్యనిని ని 

format  చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

79. To stop video time at 8 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new blank slide as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ కొత ాblank slide ని ఇనస ర్ట ్చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

80. To stop video time at 9 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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81. To stop video time at 10 minute 13 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 13 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the formatting on the rectangle as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

దీర ఘచతురప్సంని format  చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

 

 

 

 

 

 

82. To stop video time at 10 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to draw a table in slide and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని slide లో table ని గీయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

83. To stop video time at 11 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

84. To stop video time at 16 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to type the data in the table as shown in the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

table లో data ని టైప్ చేయమనండి. 

 

 Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

85. To stop video time at 16 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can change the design of the table? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  table design ని 

మారి గలరా? అని అడగండి.  

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

86. To stop video time at 17 minute 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 29 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the design of the table as shown in 

the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

table design ని మారి మనండి. 

Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

87. To stop video time at 17 minute 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to insert a new slide and link another 

document with help of ‘Hyperlink’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ కొత ాslide ని ఇనస ర్ట ్చేసి 

ద్యనిలో ‘Hyperlink’  సహాయంతో మర౉క్ document కి లింక్ట  చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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88. To stop video time at 18 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

కొత ాslide ని ఇనస ర్ట ్చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

89. To stop video time at 18 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

90. To stop video time at 20 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
Now just check whether they inserted ‘Hyperlink’ or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Hyperlink’ ని ఇనస ర్ట ్చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

91. To stop video time at 20 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do ‘Copy’ and ‘Paste’ of slide number 3 and 

4 and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మూడవ మరియు న్నలుగవ slide 

లని ‘Copy’ మరియు ‘Paste’ చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

92. To stop video time at 21 minutes 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to copy the slides as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide లని copy చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి  ప్లల చేయండి. 

 

 

 

 

93. To stop video time at 21 minutes 36seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to ‘Paste’ which they had copied. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  copy చేసిన ద్యనిని paste 

చేయమనండి. 

 

Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 



   

41 
 

94. To stop video time at 22 minutes 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to do ‘Undo’ and ‘Redo’ and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Undo’ మరియు  ‘Redo’ 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

95. To stop video time at 22 minutes 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
96. To stop video time at 23 minutes 00 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 23 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have practiced ‘Undo’ and ‘Redo’ or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు Undo’ మరియు  ‘Redo’ option లని practice చేశారొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

97. To stop video time at 23 minutes 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to hide some option of standard toolbars such 

as ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy and Paste’ and ‘Undo and Redo’ 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని standard toolbar యొక్క  కొనిి  

option లు ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy , Paste’ మరియు Undo, 

Redo చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

98. To stop video time at 23 minutes 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

99. To stop video time at 24 minutes 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have hidden ‘these options’ or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ఈ option లని hide చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

100. To stop video time at 24 minutes 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 

Stop video here and ask students to save their file to the ‘Desktop’ and then play 

the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని ‘Desktop’  పైన save 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

101. To stop video time at 24 minutes 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

102. To stop video time at 25 minutes 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have saved their file or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు file ని save చేశారొ లేదో చెక్ట చేసి తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

103. To stop video time at 25 minutes 42 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 42 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know there are how many methods are there to 

convert ‘PDF’ file? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘PDF’ file లోకి మారి టానికి ఎనిి  

పద్దతులు ఉని్న యో వాళ్ు  కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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104. To stop video time at 26 minutes 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

105. To stop video time at 27 minutes 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Now just check whether they have converted their file into PDF or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు వాళ్ు  file  ని PDF లోకి  మారాి రొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

106. To stop video time at 28 minutes 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to close their file and shout down the 

computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 3 

Impress 2 Class 3 యొక్క పూర్తి టీచర్ manual. 
Summaries 

Class 3 సార్ాాంశాం 

 

 How to create a ‘Template’? 

 ‘Template’ ని ఎలా కరియేట్ చేయాలి? 

 Why we use ‘Properties’ option? 

 మనము Properties’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to send any document to another user? 

 ఏద ైనా document ని వేర్ే user కర ఎలా పంప ంచాలి?  
 Why we use ‘Printer setting’ option? 

 మనము Printer setting’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to insert a new slide? 

 కొతా్ slide ని ఎలా ఇనసర్్ట చేయాలి? 

 Why we use ‘Preview in web browser’ option?  

 మనము ‘Preview in web browser’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to hide and unhide ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 Why we use ‘Line and filling toolbar’?  

 మనము‘Line and filling toolbar’ ని ఎందుకు ఉపయోగిస్తా ము?  
Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
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1. To stop video time at 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they remember what they had learnt in the previous 

classes of this module. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఈ module లోని ఇంతకు ముందు 

 కాలసులలో  ర్చర్థి కుని వి వాళ్ు కి గురా్థని్న యా? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

2. To stop video time at 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they know which options can be kept in ‘Standard 

toolbar’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Standard toolbar’  లో ఏ option 

లని ఉంచాలో వాళ్ు కి తెలుసా?అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

3. To stop video time at 52 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 52 సెక్న్ల  వద్ద  ఆపాండి. 
 

 
Stop video here and ask there are how many methods to insert a new slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొత ాslide ని ఇనస ర్ట ్చేయటానికి 

ఎనిి  పద్దతులు ఉని్న యి? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

4. To stop video time at 1 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 34 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask what will they do to make more than one image of the 

same picture. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్టే పక్ి ర్ట ని ఑క్టి క్ంటే 

ఎకుక వ పకి్ ర్థలగా చేయటానికి వాళ్ళు  ఏమి చేసాార్థ? అని అడగండి.    

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 



   

49 
 

 

 

 

5. To stop video time at 1 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 56 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ ని open 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

6. To stop video time at 2 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to insert 3 slides and type the given paragraph 

on the first slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మూడు slide లని ఇనస ర్ట ్చేసి 

మొద్టి slide లో ఇచిి న ప్లరాని టైప్ చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
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7. To stop video time at 2 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to insert any picture on the second slide and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని రండవ slide లో ఏదైన్న పక్ి ర్ట ని 

ఇనస ర్ట ్చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

8. To stop video time at 4 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert any picture on the second slide as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

రండవ slide లో ఏదైన్న పకి్ ర్ట ని ఇనస ర్ట ్చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

9. To stop video time at 5 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw a shape and also ask to do formatting 

in the drawing as shown in the video and then play the video again. 



   

51 
 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ shape ని గీయమనండి 

మరియు వీడియోలో చూపంచిన విధముగా drawing లో format 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 
10. To stop video time at 6 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and tell students now they will learn about ‘Wizard’ option and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులకి ఇప్పప డు వాళ్ళు  ‘Wizard’ option 

గురించి ర్చర్థి కుంటార్థ అని చెపప ండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

11. To stop video time at 6 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Letter’ option as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

‘Wizard’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోలో చూపంచిన 

విధముగా ‘Letter’ option ని select చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
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12. To stop video time at 7 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

13. To stop video time at 7 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

14. To stop video time at 9 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
Now check whether they have created ‘Letter’ format or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Letter’ format ని create చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

15. To stop video time at 9 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and tell students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Fax’ option as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

‘Wizard’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోలో చూపంచిన 

విధముగా ‘Fax’ option ని select చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
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16. To stop video time at 10 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

17. To stop video time at 11 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the next option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

తర్థవాత option ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

18. To stop video time at 11 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 18 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the next option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

తర్థవాత option ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

19. To stop video time at 12 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to click on the ‘Finish’ button and then save 

the template as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Finish’ button  ని కి లక్ట  చేసి 

తర్థవాత వీడియోలో చూపంచిన విధముగా template ని save 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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Just check whether they have created ‘Fax’ format or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Fax’ format ని create చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

20. To stop video time at 12 minute 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 29  సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and tell students to use the presentation option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

presentation option ని ఉపయోగించమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

21. To stop video time at 13 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and tell students to use the ‘Web page’ option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Web page’ option ని ఉపయోగించమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

22. To stop video time at 13 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and tell students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Document converter’ option as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

‘Wizard’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోలో చూపంచిన 

విధముగా ‘Document converter’ option ని select చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

   

23. To stop video time at 14 minute 45 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 14 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘Document converter’ option as 

shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Document converter’ option ని ఉపయోగించమనండి. 

 

Now just check whether they have used ‘Wizard’ option or not and play the 

video again. 
ఇప్పప డు విద్యా ర్థులు ‘Wizard’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

24. To stop video time at 15 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they can tell why we use ‘Send’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Send’ option ని ఎందుకు 

ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

25. To stop video time at 16 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to click on ‘File’ menu and then click 

‘Document as Email’ option as shown in the video and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

వీడియోలో చూపంచిన విధముగా ‘Document as Email’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

26. To stop video time at 17 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

Note: - tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

నోట్: విద్యా ర్థులకి ‘Send’ button ని కి లక్ట చేయవలసిన అవసరం లేద్ని 

చెపప మనండి. ఎందుక్ంటే email ని పంపంచటానికి internet connection 

కావాలి. 

27. To stop video time at 17 minute 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask if they know what happens with ‘Properties’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Properties’ option ని ఊపయోగిస్త ా

ఏమి జర్థగుతుందో వాళ్ు  కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

28. To stop video time at 18 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on ‘File’ menu and then click 

‘Properties’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

వీడియోలో చూపంచిన విధముగా ‘Properties’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

29. To stop video time at 19 minute 57 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19  నిమషాల 57 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

30. To stop video time at 21 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

31. To stop video time at 21 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can tell what happens with ‘Printer setting’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Printer setting’option ని 

ఊపయోగిస్త ాఏమి జర్థగుతుందో వాళ్ళు  చెపప గలరా? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

32. To stop video time at 22 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on ‘File’ menu and then click ‘Printer 

setting’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి తర్థవాత 

వీడియోలో చూపంచిన విధముగా ‘Printer setting’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

33. To stop video time at 23 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

34. To stop video time at 23 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to check out the ‘Printing shortcut’ option as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Printing shortcut’ check out చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

35. To stop video time at 23 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use ‘Paper quality and Effects’ as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Paper quality and Effects’ option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

36. To stop video time at 25 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used the ‘Printer setting’ option or not and 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Printer setting’ option ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

37. To stop video time at 26 minute 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Template’ option? 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని ‘Template’ option ని ఎందుకు 

ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

38. To stop video time at 27 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option and also ask to save the document as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి, 

‘Template’ option ని సెలెక్ట ్చేసుకొని తర్థవాత వీడియోలో చూపంచిన 

విధముగా  document ని save చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

39. To stop video time at 29 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use ‘Export’ the document as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా  

‘Export’ the document  option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

40. To stop video time at 29 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా  

చేయమనండి. 

Now just check whether they have created the ‘Template’ or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Template’ ని create చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

41. To stop video time at 29 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they can tell why we use ‘Preview in Browser’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Preview in Browser’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

42. To stop video time at 31 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use ‘Preview in web browser’ option as 

shown in video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా  

‘Preview in web browser’ option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

43. To stop video time at 31 minute 28 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 31 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 4 

Impress 2 Class 4 యొక్క పూర్తి టీచర్ manual. 
Class 4 Summaries 

Class 4 సార్ాాంశాం 

 How to create ‘Template’? 

 ‘Template’ ని ఎలా కరియేట్ చేయాలి? 

 Why we use ‘Properties’ option? 

 మనము Properties’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to send any document to another user? 

 ఏద ైనా document ని వేర్ే user కర ఎలా పంప ంచాలి?  
 Why we use ‘Printer setting’ option? 

 మనము Printer setting’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to insert a new slide? 

 కొతా్ slide ని ఎలా ఇనసర్్ట చేయాలి? 

 Why we use ‘Preview in web browser’ option?  

 మనము‘Preview in web browser’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to hide and unhide ‘Standard toolbar’? 

 ‘Standard toolbar’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 How to show Standard toolbar? 

 Standard toolbar ని ఎలా చూప ంచాలి? 

 Why we use ‘Line and filling toolbar’?  

 మనము‘Line and filling toolbar’ ని ఎందుకు ఉపయోగిస్తా ము?  
Now let’s start the video. 
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ఇపపుడు వీడియోని మొదలుపెడదాము. 
 

 

 

 

44. To stop video time at 42 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 42 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they know what will they do for seeing slides on the 

web browser? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని web browser లో slide లని 

చూడటానికి వాళ్ళు  ఏమి చేసాారొ వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

45. To stop video time at 1 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 00 సెక్న్ల  వద్ద  ఆపాండ.ి  
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Stop video here and ask if they can tell how to type in blank slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని blank slide లో ఎలా టైప్ చేయాలో 

వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

46. To stop video time at 1 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 16 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask which option will be used for sending a document to 

another user? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని document ని వేరే user కి 

పంపంచటానికి ఏ option ని ఉపయోగిసాార్థ? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

47. To stop video time at 1 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can tell where is the slide pane located in the 

‘Impress’ file. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress’ file లో slide pane ఎక్క డ 

ఉంట్లందో  వాళ్ళు  చెపప గలరా? అని అడగండి. 

 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

48. To stop video time at 1 minute 59 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 59 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask which option will be used to know all the information 

about ‘Impress’ file? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress’ file గురించిన 

సమాచారం అంతా తెలుసుకోవటానికి ఏ option ని ఉపయోగిసాార్థ? అని 

అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

49. To stop video time at 2 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress’ file ని open 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

50. To stop video time at 2 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to insert 3 slides and type the given paragraph 

on the first slide and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మూడు slide లు ఇనస ర్ట ్చేసి 

మొద్టి slide లో ఇచిి న ప్లరాని టైప్ చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి.  

51. To stop video time at 2 minute 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to do practice of ‘Send’ option and then play 

the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Send’ option ని practice 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి.  

 

 

 

52. To stop video time at 3 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File’ menu and select 

‘Document as email’ option and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి, 

‘Document as email’ option ని సెలెక్ట ్చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

53. To stop video time at 4 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 
54. To stop video time at 4 minute 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 29 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to apply ‘Template’ option and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Template’ option ని అప్ల ల 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

55. To stop video time at 4 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option and then select the save option as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి, 

‘Template’ option ని కి లక్ట చేసి తర్థవాత వీడియోలో చూపంచిన విధముగా 

save option ని సెలెక్ట ్చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 
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56. To stop video time at 6 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to ‘Export’ the document as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

document ని export చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

57. To stop video time at 06 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have made ‘Template’ or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Template’ ని చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

58. To stop video time at 06 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to create the ‘Fax’ format and the play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Fax’ format ని create 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

59. To stop video time at 07 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File’ menu and then select 

‘Fax’ option of ‘Wizard’ as shown in the video and then play the again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి, తర్థవాత 

వీడియోలో చూపంచిన విధముగా ‘Wizard’ లోని ‘Fax’ option ని సెలెక్ట ్

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

60. To stop video time at 08 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 
61. To stop video time at 09 minute 01 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 09 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have Created ‘Fax format’ or not and play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులు ‘Fax format’ ని create చేశారొ లేదో 

చెక్ట చేయండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

62. To stop video time at 09 minute 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to do practice of ‘Printer setting’ option and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Printer setting’ option ని practice 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

63. To stop video time at 09 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File’ menu and then select 

‘Printer setting’ option as shown in the video and then play the again. 

 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘File’ menu పైన కి లక్ట చేసి, తర్థవాత 

వీడియోలో చూపంచిన విధముగా ‘Printer setting’ option ని సెలెక్ట ్ 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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64. To stop video time at 14 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘Advance and Printing setting’ as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Advance and Printing setting’ option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

65. To stop video time at 11 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘paper quality and Effect’ as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘paper quality and Effect’ option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

66. To stop video time at 11 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have practiced ‘Printer setting’ option or not and 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Printer setting’ option  ని practice చేశారొ  లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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67. To stop video time at 12 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 

 

Stop video here and ask students to do practice of ‘Preview in web browser’ and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  ‘Preview in web browser’ option 

ని practice చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

68. To stop video time at 12 minute 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have practiced ‘Preview in web browser’ or not 

and play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘‘Preview in web browser’ option  ని practice చేశారొ  

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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69. To stop video time at 12 minute 58 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to hide some options such as ‘Save’ ‘open’ and 

‘Hyperlink’ from ‘Standard toolbar’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  ‘Save’, ‘open’ మరియు  ‘Standard 

toolbar’ లోని  ‘Hyperlink’ లాంటి కొనిి  option లని hide చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

70. To stop video time at 14 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to unselect these options and click on ‘OK’ 

button as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఈ option లని unselect చేసి  

తర్థవాత వీడియోలో చూపంచిన విధముగా ‘OK’ button ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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71. To stop video time at 14 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
 

Stop video here and ask students to draw their name on the slide with help of 

‘Fontwork’ option and also do formatting on it and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Fontwork’ option  సహాయంతో 

వాళ్ు  ప్లర్థని slide లో గీసి ద్యనిలో formatting ని చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

72. To stop video time at 15 minute 42 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 42 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert ‘Font work gallery’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Font work gallery’ ని ఇనస ర్ట ్చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

73. To stop video time at 16 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

74. To stop video time at 16 minute 59 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

 

Now just check whether they have practiced ‘Fontwork’ option or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Fontwork’ option  ని practice చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 
75. To stop video time at 17 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
 

Stop video here and ask students to bring back those options which they had 

hidden and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  hide చేసిన option లని 

వెనుక్కి తీసుకురమమ నండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి.  

 

76. To stop video time at 18 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి 

 

Now just check whether they have gotten back those options or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు వాళ్ళు  hide చేసిన option లని వెనుక్కి 

తీసుకువచాి రొ లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

77. To stop video time at 18 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to close their file and shout down the 

computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 5 

Impress 2 Class 5 యొక్క పూర్తి టీచర్ manual. 
Class 5 Summaries 

Class 5 సార్ాాంశాం 

 

 Why we use ‘Points’ 

 మనము‘Points’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Glue points’ option? 

 మనము ‘Glue points’ option ని ఎందుకు ఉపయోగిస్తా ము? 

 Why we use ‘Field option’? 

 మనము‘Field option’ ని ఎందుకు ఉపయోగిస్తా ము?  
 How to do any ‘Formatting on drawing? 

 ఏద ైనా drawing లో ఏద ైనా Formatting ని ఎలా చేయాలి? 

 How to insert a new slide? 

 New slide ని ఎలా ఇనసర్్ట చేయాలి? 

 How to use ‘Slide master’?  

 ‘Slide master’ ని ఎలా ఉపయోగించాలి? 

 How to hide and unhide ‘Comments’? 

 ‘Comments’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 How to insert comment? 

 Comment ని ఎలా ఇనసర్్ట చేయాలి? 

 What happens by ‘Navigator’ option? 

 ‘Navigator’ option ని ఉపయోగిస్తా  ఏమి జరుగుత్ ంద?ి 

 Why we use ‘Zoom’ option? 

 మనము ‘Zoom’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 ‘Date’, ‘Time’ మరి్యు ‘Page number’ ని ఎలా ఇనసర్్ట చేయాలి? 
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Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
78. To stop video time at 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 46 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they can tell why we use ‘Line and filling’ toolbar? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Line and filling’ toolbar 

ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

79. To stop video time at 2 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to hide and unhide the ‘Slide pane’ as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Slide pane’ ని hide మరియు unhide చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
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80. To stop video time at 2 minute 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know what is ‘Properties option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Properties option అంటే ఏమిటో 

వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

81. To stop video time at 3 minute 23 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 23 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask there are how many methods to print ‘Impress file’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ ని print చేయటానికి 

ఎనిి  పద్దతులు ఉని్న యి?అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

82. To stop video time at 4 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask to if they know which shortcut command will be used 

to get a print out? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని print out  ని పంద్టానికి ఏ 

shortcut command ని ఉపయోగిసాారొ వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

83. To stop video time at 4 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Templates’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Templates’ option ని  

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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84. To stop video time at 4 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Impress fileని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

85. To stop video time at 5 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to type the given paragraph on the first slide 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మొద్టి slide లో ఇచిి న ప్లరాని 

టైప్ చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

86. To stop video time at 5 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students if they have typed the paragraph? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  ప్లరాని టైప్ చేశారా?అని 

అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

87. To stop video time at 5 minute 53 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 53 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert 10 (ten) slides. 
ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని పది  slide లు ఇనస ర్ట ్

చేయమనండి. 

 Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

88. To stop video time at 5 minute 58 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and check whether they have inserted ten slides or not and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులు పది  slide లని ఇనస ర్ట ్చేశారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

89. To stop video time at 6 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 18 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert any object using ‘Object’ option and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Object’ option ని ఉపయోగించి 

ఏదైన్న object ని ఇనస ర్ట ్ చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

90. To stop video time at 7 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert ten slides as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

పది  slide లు ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

91. To stop video time at 10 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw shape as shown in the video and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

shape లని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

92. To stop video time at 10 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

93. To stop video time at 11 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

94. To stop video time at 15 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have drawn some shapes in slides numbers 2 to 8 

or not and play the video again. 

ఇప్పప డు విద్యా ర్థులు రండవ slide నుంచి ఎనిమిద్వ slide వరకు కొనిి  

shape లని గీశారొ లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

95. To stop video time at 15 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 



   

87 
 

 

Stop video here and ask why use ‘Points’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Points’ option ని 

ఎందుకు ఉపయోగిసాాము?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

 

96. To stop video time at 16 minute 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw a line as shown in the video and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ line ని గీయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి 

 

97. To stop video time at 16 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Points’ opiton as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Edit menu’  పైన తర్థవాత ‘Points’ option పైన కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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98. To stop video time at 17 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

99. To stop video time at 17 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

100. To stop video time at 20 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

101. To stop video time at 21 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 
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Now just check whether they have used ‘Points option’ or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Points option’ ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

102. To stop video time at 21 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why use ‘Glue Points’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Glue Points’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

103. To stop video time at 22 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw two shapes as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

రండు shape లని గీయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

104. To stop video time at 23 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Glue Points’ opiton as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Edit menu’ పైన కి లక్ట చేసి తర్థవాత ‘Glue Points’ ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

105. To stop video time at 25 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

106. To stop video time at 27 minutes 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 
 

107. To stop video time at 27 minutes 13 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 13 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can tell why we use ‘Fields’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Fields’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

108. To stop video time at 29 minutes 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert ‘Date’, ‘Time’ and ‘Page number’ as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Date’, ‘Time’ మరియు ‘Page number’ ఇనస ర్ట ్చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

109. To stop video time at 30 minutes 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Fields’ opiton as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Edit menu’  ని కి లక్ట చేసి తర్థవాత ‘Fields’ opiton ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

110. To stop video time at 30 minutes 40 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 30 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

111. To stop video time at 31 minutes 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have changed formatting of ‘Fields’ or not and 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Fields’  formatting  ని మారాి రొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

112. To stop video time at 31 minutes 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students if they remember what options they learnt in 

‘View menu’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘View menu’ లో  ఏ option లు 

ర్చర్థి కుని్న రొ వాళ్ళు  గురా్థంచుకుని్న రా? అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

113. To stop video time at 32 minutes 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 32 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Slide master’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Slide master’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

114. To stop video time at 33 minutes 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a slide and type some lines in slide 

with some title as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ slide ని ఇనస ర్ట ్చేసి ఏదైన్న టైటిల్ తో కొనిి  lines ని టైప్ 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

115. To stop video time at 33 minutes 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide and type some lines as 

shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ కొత ాslide ని ఇనస ర్ట ్చేసి కొనిి  lines ని టైప్ చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

116. To stop video time at 35 minutes 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘View menu’ and then click 

‘Slide master’ opiton as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘view menu’  ని కి లక్ట చేసి తర్థవాత ‘Slide master’ opiton ని కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

117. To stop video time at 37 minutes 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 37 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

formatting చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి 

 

118. To stop video time at 38 minutes 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Master slide or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Slide master’ opiton ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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119. To stop video time at 39 minutes 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 39 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use the ‘Color and grayscale’ 

option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Color and grayscale’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

120. To stop video time at 40 minutes 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40  నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

formatting చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

121. To stop video time at 40 minutes 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 
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Now just check whether they have used ‘color and grayscale’ or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘color and grayscale’ opiton ని ఉపయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

122. To stop video time at 41 minutes 13 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 41 నిమషాల 13 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to hide and unhide the comment box as and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని comment box  ని hide మరియు 

unhide చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

123. To stop video time at 41 minutes 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 41 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Comment’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Insert menu’ ని కి లక్ట చేసి, తర్థవాత ‘Comment’ option ని సెలెక్ట ్

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

124. To stop video time at 42 minutes 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 42 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to type some lines in the ‘Comment box’ as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Comment box’ లో కొనిి  lines ని టైప్ చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

125. To stop video time at 43 minutes 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 43 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to hide and unhide the ‘Comment’ as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

Comment option ని hide మరియు unhide చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

126. To stop video time at 43 minutes 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 43 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know what happens with ‘Navigator’ and why 

we use it? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Navigator’ option ని ఉపయోగిస్త ా

ఏమి జర్థగుతుంది మరియు మనము ద్యనిని ఎందుకు ఉపయోగిసాామో 

వాళ్ు కి తెలుసా ? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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127. To stop video time at 44 minutes 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 44 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Navigator’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘View’ menu’ ని కి లక్ట చేసి, తర్థవాత ‘Navigator’ option ని సెలెక్ట ్

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

128. To stop video time at 45 minutes 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 45 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to move one slide to another with help of 

‘Navigator’ option as shown in the video and then play the video again. 

 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Navigator’ option సహాయంతో ఑క్ slide నుంచి మర౉క్ slide కి 

వెళ్ు మనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

129. To stop video time at 46 minutes 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 46 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have used ‘Navigator’ or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు Navigator’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

130. To stop video time at 47 minutes 25 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 47 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Zoom’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘View’ menu’ ని కి లక్ట చేసి, తర్థవాత ‘Zoom’ option ని సెలెక్ట ్చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

131. To stop video time at 47 minutes 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 47 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

132. To stop video time at 48 minutes 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 48 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

133. To stop video time at 48 minutes 53 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 48 నిమషాల 53 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

134. To stop video time at 50 minutes 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 50 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 



   

100 
 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Zoom’ or not and play the video again. 
ఇప్పప డు విద్యా ర్థులు ‘Zoom’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

135. To stop video time at 50 minutes 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 50 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 6 

Impress 2 Class 6 యొక్క పూర్తి టీచర్ manual. 
Summaries 

Class 6 సార్ాాంశాం 

 Why we use ‘Points’ 

 మనము‘Points’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Glue points’ option? 

 మనము ‘Glue points’ option ని ఎందుకు ఉపయోగిస్తా ము? 

 Why we use ‘Field option’? 

 మనము‘Field option’ ని ఎందుకు ఉపయోగిస్తా ము?  
 How to do any ‘Formatting on drawing? 

 ఏద ైనా drawing లో ఏద ైనా Formatting ని ఎలా చేయాలి? 

 How to insert a new slide? 

 New slide ని ఎలా ఇనసర్్ట చేయాలి? 

 How to use ‘Slide master’?  

 ‘Slide master’ ని ఎలా ఉపయోగించాలి? 

 How to hide and unhide ‘Comments’? 

 ‘Comments’ ని ఎలా hide మరి్యు unhide చేయాలి? 

 How to insert comment? 

 Comment ని ఎలా ఇనసర్్ట చేయాలి? 

 What happens by ‘Navigator’ option? 

 ‘Navigator’ option ని ఉపయోగిస్తా  ఏమి జరుగుత్ ంద?ి 

 Why we use ‘Zoom’ option? 

 మనము ‘Zoom’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 ‘Date’, ‘Time’ మరి్యు ‘Page number’ ని ఎలా ఇనసర్్ట చేయాలి? 
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Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
136. To stop video time at 1 minute 13 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 13 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know which shortcut command will be used for 

‘Slide show’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Slide show’ కి ఏ short cut 

command ని ఉపయోగిసాారొ వాళ్ళు  చెపప గలరా? అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

137. To stop video time at 1 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can tell what happens with ‘side bar’ and how to 

hide this? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘side bar’ ని ఊపయోగిస్త ాఏమి 

జర్థగుతుందో మరియు ద్యనిని ఎలా hide చేయాలో వాళ్ళు  చెపప గలరా? 

అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

138. To stop video time at 2 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాం 07 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if slide view has been changed, how to bring back in 

normal view? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని slide view మారితే ద్యనిని తిరిగి  

normal view  లోకి ఎలా  తీసుకురావాలి? అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

139. To stop video time at 2 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Fields’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Fields’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

140. To stop video time at 2 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Impress fileని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

141. To stop video time at 3 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they can tell what they learnt in previous class? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇంతకు ముందు కాలస్ లో వాళ్ళు  

ఏమి ర్చర్థి కున్ని రొ చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

142. To stop video time at 3 minute 34 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 03 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to insert 4 slides and type the given paragraph 

on the first slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని న్నలుగు slide లని ఇనస ర్ట ్చేసి 

మొద్టి slide లో ఇచిి న ప్లరా ని టైప్ చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

143. To stop video time at 3 minute 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to change their name style with help of ‘Font 

work’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Font work’ option సహాయంతో 

వాళ్ు  name style ని మారి మనండి.  

144. To stop video time at 4 minute 09 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 04 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert three slides as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

మూడు slide లని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

145. To stop video time at 4 minute 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to select any ‘Font work’ style as shown in the 

video and then play the video again.  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న ‘Font work’ style ని సెలెక్ట ్చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

 

146. To stop video time at 4 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

147. To stop video time at 5 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have used ‘Font work’ or not and play the video 

again. 



   

108 
 

ఇప్పప డు విద్యా ర్థులు రండవ ‘Font work’ option ని ఊయయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

148. To stop video time at 5 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask them if they know how many ways one can view a 

slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని slide ని ఎనిి  రకాలుగా 

చూడవచ్చి  వాళ్ు  కి తెలుసా ?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

149. To stop video time at 6 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask the students to change the view of the slide and bring 

back into normal view and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో slide view ని మారిి  

ద్యనిని తిరిగి normal view లోకి మారి మనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

150. To stop video time at 6 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the view of the slide as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide view ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

151. To stop video time at 8 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have changed the view of the slides or not and 

play the video again. 

ఇప్పప డు విద్యా ర్థులు slide ల view ని మారాి రొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

152. To stop video time at 8 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert some pictures and write some 

comments on the slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొనిి  పకి్ ర లని ఇనస ర్ట ్చేసి slide 

లో కొనిి  comment లని వతాయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

153. To stop video time at 9 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert the comment box and type some text 

in it as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

comment box  ని ఇనస ర్ట ్చేసి ద్యనిలో ఏదైన్న text ని టైప్ చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

154. To stop video time at 10 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have hidden the comments or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు comment లని hide చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 
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155. To stop video time at 10 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask, how to see the picture in the slide and how to move 

from one picture to another? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  slide లో  పకి్ ర్ట ని ఎలా చూడాలి 

మరియు ఑క్ పక్ి ర్ట నుంచి మర౉క్ పక్ి ర్ట కి ఎలా వెళ్ళు లి?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

] 

 

156. To stop video time at 11 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘View menu’ and then select 

the ‘Navigator’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘View’ menu’ ని కి లక్ట చేసి, తర్థవాత ‘Navigator’ option ని సెలెక్ట ్

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

157. To stop video time at 12 minute 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have practiced ‘Navigator’ option or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Navigator’ option ని practice చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

158. To stop video time at 13 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to show ‘Comment’ which they had hidden 

and type ‘Computer Shiksha’ in the comment box and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  hide చేసిన comment లని 

క్నిపంచేటట్లల చేసి comment box లో ‘Computer Shiksha’ అని టైప్ 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

159. To stop video time at 13 minute 57 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 57 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have shown the ‘Comment’ or not and then play 

the video again. 
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ఇప్పప డు విద్యా ర్థులు comment లని క్నిపంచేటట్లల లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

160. To stop video time at 14 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students, how will they show and use the master slide 

option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  master slide option ని ఎలా 

క్నిపంచేటట్లల చేసాార్థ మరియు ఉపయోగిసాార్థ? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

161. To stop video time at 14 minute 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘View menu’ and then click on 

the ‘Master slide’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘View’ menu’ ని కి లక్ట చేసి, తర్థవాత ‘Master slide’ option ని  కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

162. To stop video time at 15 minute 52 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 15 నిమషాల 52 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the formatting as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

formatting చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

163. To stop video time at 16 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

164. To stop video time at 17 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have practiced ‘Master slide’ or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Master slide’ option ని practice చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

165. To stop video time at 17 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask how will they hide ‘Side bar’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  ‘Side bar’ ని ఎలా hide 

చేసాార్థ ?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

166. To stop video time at 18 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have practiced the ‘Sidebar’option or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు‘Sidebar’option ని practice  చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

167. To stop video time at 18 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to hide ‘Line and filling, ‘Drawing bar’ and 

‘Standard toolbar’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Line and filling, ‘Drawing bar’ 

మరియు ‘Standard toolbar’ ని hide చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

168. To stop video time at 19 minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 03 సెక్న్ల  వద్ద  ఆపాండ.ి 

Stop video here and ask students to hide ‘Drawing toolbar’ as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Drawing toolbar’ ని hide చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

169. To stop video time at 19 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to hide ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Line and filling’ toolbar’ మరియు ‘Standard toolbar’ ని hide  

చేయమనండి.  

Now just check whether they have used the ‘Toolbar’ option or not and then 

play the video again. 
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ఇప్పప డు విద్యా ర్థులు ‘Toolbar’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

170. To stop video time at 20 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to show ‘Standard toolbar’, ‘Line and filling’ 

and ‘Drawing toolbar’ then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Standard toolbar’ ,‘Line and 

filling’ toolbar’ మరియు ‘Drawing toolbar’ ని క్నిపంచేటట్లల 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

171. To stop video time at 20 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to show ‘Drawing toolbar’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Drawing toolbar’ ని క్నిపంచేటట్లల చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

172. To stop video time at 21 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do show ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 



   

118 
 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Line and filling’ toolbar’ మరియు  ‘Standard toolbar’ ని క్నిపంచేటట్లల 

చేయమనండి. 

Now just check and play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

173. To stop video time at 21 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to draw two objects and join them with help of 

‘Glue points’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని రండు object లని గీసి వాటిని 

‘Glue points’ option సహాయంతో  క్లపమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి.   

 

174. To stop video time at 22 minute 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw two objects as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

రండు object లని గీయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

175. To stop video time at 23 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have practiced ‘Glue points’ or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Glue points’ option ని practice  చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

176. To stop video time at 23 minute 52 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 52 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to draw a line and use ‘Points in this line and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

line ని గీసి ఈ line లో Points option ని ఉపయోగించమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

177. To stop video time at 24 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  
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178. To stop video time at 24 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

179. To stop video time at 25 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they practiced ‘Points’ or not and play the video again. 

ఇప్పప డు విద్యా ర్థులు Points option ని practice  చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

180. To stop video time at 25 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to close their file and shut down the computer. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 

 

 

 

 

 

 Complete teacher’s manual for Open office Impress 2 Class 7 

Impress 2 Class 7 యొక్క పూర్తి టీచర్ manual. 
Class 7 Summaries 

Class 7 సార్ాాంశాం 

 Why we use ‘Expand and summary slide’? 

 మనము‘Expand and summary slide’ option ని ఎందుకు ఊపయోగిస్తా ము?  
 Why we use ‘animated image’ option? 

 మనము‘animated image’ option ని ఎందుకు పయోగిస్తా ము?  
 Why we use ‘Movie and sound’? 

 మనము‘Movie and sound’ option ని ఎందుకు పయోగిస్తా ము?  
 What is ‘object’ and ‘chart’ option? 

 ‘object’ మరి్యు  ‘chart’ option అంటే ఏమిట?ి 

 Why we use ‘position and size’? 

 మనము ‘position and size’ ని ఎందుకు ఊపయోగిస్తా ము?  
 Why we use ‘line’ option? 

 మనము ‘line’ option ని ఎందుకు పయోగిస్తా ము? 

 What is area option? 

 మనము area option ని అంటే ఏమిట?ి 

 How to crop a picture? 
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 ప కార్ట ని ఎలా crop చేయాలి? 

 How to use style and formatting? 

 Style and formatting ని ఎలా పయోగించాలి? 

 How to correct spelling? 

 Spelling ని ఎలా correct చేయాలి? 

 How to change language? 

 Language ని ఎలా మార్తాలి? 

Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
181. To stop video time at 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they can tell what they learnt in previous class? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇంతకు ముందు కాలస్ లో ఏమి 

ర్చర్థి కున్ని రొ వాళ్ళు  చెపప గలరా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

182. To stop video time at 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 55 సెక్న్ల  వద్ద  ఆపాండి. 
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Stop video here and ask what they had learnt in ‘Standard toolbar’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Standard toolbar’ option  లో 

వాళ్ళు  ఏమి ర్చర్థి కున్ని ర్థ? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

183. To stop video time at 1 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell how to hide ‘Grid’ from ‘Impress file’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Impress file’ లో ‘Grid’ option ని 

ఎలా hide చేయాలో వాళ్ళు  చెపప గలరా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

184. To stop video time at 2 minute 00 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 02 నిమషాం 00 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Points’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Points’ option ని 

ఎందుకు పయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

185. To stop video time at 2 minute 31 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 31 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Fields’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Fields’ option ని 

ఎందుకు పయోగిసాామో వాళ్ళు  చెపప గలరా? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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186. To stop video time at 3 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Hyperlink’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Hyperlink’ option ని 

ఎందుకు పయోగిసాామో వాళ్ళు  చెపప గలరా? అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

187. To stop video time at 3 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Impress fileని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

188. To stop video time at 5 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to type the given paragraph on the slide and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇచిి న ప్లరాని slide లో టైప్ 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

189. To stop video time at 5 minute 06 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 06 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and check whether they have typed paragraph or not and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులు ప్లరా ని టైప్  చేశారొ లేదో చెక్ట 

చేయండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

190. To stop video time at 5 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Summary slide’ option? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Summary slide’ option ని 

ఎందుకు పయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

191. To stop video time at 6 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a slide and then give the title and also 

draw an object as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ slide ని ఇనస ర్ట ్చేసి title ని ఇవవ మనండి.మరియు ఑క్ object ని 

గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

192. To stop video time at 7 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check and then play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

193. To stop video time at 7 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they can tell why we use ‘Expand slide’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Expand slide’ option ని 

ఎందుకు పయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

194. To stop video time at 9 minute 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have applied Expand slide or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Expand slide’ option ని అప్ల ల చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

195. To stop video time at 9 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Animated image’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Animated image’ option 

ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

196. To stop video time at 10 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Animated image’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Insert menu’ ని కి లక్ట చేసి, తర్థవాత ‘Animated image’ option ని సెలెక్ట ్

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

197. To stop video time at 10 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a picture and click on the apply object 

as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ పకి్ ర్ట ని ఇనస ర్ట ్చేసి apply object పైన కి లక్ట చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 
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198. To stop video time at 11 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

199. To stop video time at 11 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

200. To stop video time at 13 minute 51seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Apply object’ and then click 

on the ‘Create’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Apply object’ ని  కి లక్ట చేయమనండి. తర్థవాత ‘Create’ option  ని కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

201. To stop video time at 14 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on ‘Insert menu’ and then click on the 

‘Movie and Sound’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Insert menu’ ని కి లక్ట చేసి, తర్థవాత ‘Movie and Sound’ option ని కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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202. To stop video time at 15 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న వీడియోని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

203. To stop video time at 16 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have inserted a video or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు  వీడియో ని ఇనస ర్ట ్ చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

204. To stop video time at 16 minute 42 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 42 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Object’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Object’ option ని 

ఎందుకు పయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

205. To stop video time at 17 minute 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Insert menu’ and then click on 

‘Object’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Insert menu’ ని కి లక్ట చేసి, తర్థవాత ‘Object’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

206. To stop video time at 18 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

207. To stop video time at 19 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check and then play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

208. To stop video time at 21 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an object and also ask to copy and 

paste as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ object ని గీయమనండి  తర్థవాత copy  మరియు paste చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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209. To stop video time at 21 minute 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 29 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Position and size’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని కి లక్ట చేసి తర్థవాత Position and size’ option ని కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

210. To stop video time at 21 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

211. To stop video time at 22 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

212. To stop video time at 23 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

213. To stop video time at 24 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Position and Size’ option or not and 

then play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Position and Size’ option ని ఊపయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

214. To stop video time at 25 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw a ‘Line’ as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ line ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

215. To stop video time at 26 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Line’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’  ని కి లక్ట చేసి తర్థవాత  ‘Line’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

216. To stop video time at 26 minute 27 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 26 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

217. To stop video time at 27 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

218. To stop video time at 28 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used the ‘Line’ option or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Line’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

219. To stop video time at 29 minute 12 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 12 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Area’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Area’ option ని ఎందుకు 

ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

220. To stop video time at 29 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Area’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’  ని కి లక్ట చేసి తర్థవాత ‘Area’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

221. To stop video time at 30 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘Shadow’ option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Shadow’ option ని ఉపయోగించమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

222. To stop video time at 31 minute 32 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 31 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use the ‘Transparency’ option as shown in 

the video and then play the video again.. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Transparency’ option ని ఉపయోగించమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

223. To stop video time at 31 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 31 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

224. To stop video time at 33 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Area’ option and then play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Area’ option ని ఊపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

225. To stop video time at 33 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know what happens with ‘Text’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Text’ option ని ఊపయోగిస్త ాఏమి 

జర్థగుతుందో వాళ్ు  కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

 

 

 

226. To stop video time at 34 minute 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 34 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Text’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’  ని కి లక్ట చేసి తర్థవాత ‘Text’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

227. To stop video time at 34 minute 58 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 34 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 



   

139 
 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

228. To stop video time at 35 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

229. To stop video time at 36 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 36 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have applied text animation or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు text animation ని అప్ల ల  చేశారొ  లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

230. To stop video time at 36 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 36 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we ‘Crop picture’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Crop picture’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

231. To stop video time at 37 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 37 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Crop picture’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని కి లక్ట చేసి తర్థవాత ‘Crop picture’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

232. To stop video time at 38 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

233. To stop video time at 39 minute 19 seconds in VLC Media Player. 



   

141 
 

వీడియో ని VLC Media Player లో 39 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Crop picture’ or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ‘Crop picture’ option ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

234. To stop video time at 40 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format’ and then click on 

‘Style and formatting’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని కి లక్ట చేసి తర్థవాత ‘Style and formatting’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

235. To stop video time at 40 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the background color of the slide as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide background color ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

236. To stop video time at 41 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 41 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 



   

142 
 

237. To stop video time at 41 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 41 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Formatting and style’ or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Formatting and style’ option ని ఉపయోగించారొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

238. To stop video time at 42 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 42 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell what is ‘Color replacer’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Color replacer’ option అంటే 

ఏమిటో వాళ్ళు  చెపప గలరా?అని అడగండి.  

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

239. To stop video time at 42 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 42 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేసి తర్థవాత ‘Color replacer’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

240. To stop video time at 43 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 43 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have replaced the picture’s color or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు పకి్ ర్ట color ని replace చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

241. To stop video time at 44 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 44 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Media player’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేసి తర్థవాత ‘Media player’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

242. To stop video time at 45 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 45 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న వీడియోని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

243. To stop video time at 46 minute 43 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 46 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have inserted any video or not and play the video 

again. 

ఇప్పప డు విద్యా ర్థులు ఏదైన్న వీడియోని ఇనస ర్ట ్ చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

244. To stop video time at 46 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 46 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Minimize presentation’ 

option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Minimize presentation’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

245. To stop video time at 47 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 47 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Minimize presentation’ as shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేసి తర్థవాత ‘Minimize presentation’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

246. To stop video time at 48 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 48 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

247. To stop video time at 48 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 48 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Minimize presentation’ or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Minimize presentation’ option ని ఉపయోగించారొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

248. To stop video time at 49 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 49 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office Impress 2 Class 8 

Impress 2 Class 8 యొక్క పూర్తి టీచర్ manual. 
Summaries 

Class 8 సార్ాాంశాం 

 Why we use ‘Expand and summary slide’? 

 మనము‘Expand and summary slide’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘animated image’ option? 

 మనము‘animated image’ option ని ఎందుకు పయోగిస్తా ము?  
 Why we use ‘Movie and sound’? 

 మనము‘Movie and sound’ option ని ఎందుకు పయోగిస్తా ము?  
 What is ‘object’ and ‘chart’ option? 

 ‘object’ మరి్యు  ‘chart’ option అంటే ఏమిట?ి 

 Why we use ‘position and size’? 

 మనము ‘position and size’ ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘line’ option? 

 మనము ‘line’ option ని ఎందుకు పయోగిస్తా ము? 

 What is area option? 

 మనము area option ని అంటే ఏమిట?ి 

 How to crop a picture? 

 ప కార్ట ని ఎలా crop చేయాలి? 

 How to use style and formatting? 

 Style and formatting ని ఎలా పయోగించాలి? 

 How to correct spelling? 

 Spelling ని ఎలా correct చేయాలి? 

 How to change language? 

 Language ని ఎలా మార్తాలి? 



   

148 
 

Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
 

249. To stop video time at 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they remember what they learnt in previous class? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇంతకు ముందు కాలస్ లో 

ర్చర్థి కుని వి వాళ్ు కి గురా్థని్న యా?అని అడగండి.  

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

250. To stop video time at 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 47 సెక్న్ల  వద్ద  ఆపాండి. 

 
 

Stop video here and ask if they know what is ‘animated image’? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘animated image’ అంటే ఏమిటో 

వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

251. To stop video time at 1 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 21 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask which option is used to ‘play MP3 or video’ file in 

impress slide? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని impress slide లో  MP3 లేక్ video 

file ని ప్లల చేయటానికి ఏ option ని ఉపయోగిసాార్థ? అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

252. To stop video time at 1 minute 42 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాల 42 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask what is shortcut command for ‘spelling’?  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘spelling’ కి shortcut command  

ఏమిటి ?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

253. To stop video time at 2 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask where are ‘text, area, line and styles and formatting’ 

options ?  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘text, area, line and styles and 

formatting’ options ఎక్క డ ఉంటాయి ?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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254. To stop video time at 2 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
 

 

Stop video here and ask if they can tell what is ‘’color replacer’?  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  ‘color replacer’ అంటే ఏమిటో 

వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 
జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
255. To stop video time at 2 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘minimize presentation’?  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘minimize presentation’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

256. To stop video time at 3 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to first select title slide and then play the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మొద్ట title slide ని సెలెక్ట ్

చేయమనండి .తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

257. To stop video time at 3 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 18 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to type the given line and then play the video  

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇచిి న లైన్ ని టైప్  

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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258. To stop video time at 4 minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 03 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to copy paste the line as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

line ని copy  మరియు paste చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

 

 

 

 

 

259. To stop video time at 4 minute 17 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 17 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to bring up the new slide and then ask to use 

movie and sound. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

కొత ాslide ని తీసుకురమమ నండి.తర్థవాత movie and sound option ని 

ఉపయోగించమనండి. 

 

260. To stop video time at 4 minute 40 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 04 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students insert a new slide as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ కొత ాslide ని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

261. To stop video time at 5 minute 29 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 29 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert the video and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోని ఇనస ర్ట ్చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

262. To stop video time at 5 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.. 

Now just check whether they have inserted the video or not and then play the 

video again. 

 ఇప్పప డు విద్యా ర్థులు వీడియోని ఇనస ర్ట ్ చేశారొ  లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

263. To stop video time at 6 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert the new slide and ask to make it as a 

summary slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ కొత ాslide ని ఇనస ర్ట ్చేసి 

ద్యనిని summary slide గా చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

264. To stop video time at 6 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to make the ‘Expand slide’ as shown in the 

video and then play again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Expand slide’ ని చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

265. To stop video time at 7 minute 38 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 38 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Summary slide’ or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Summary slide’ option ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

266. To stop video time at 7 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని కొత ాslide ని ఇనస ర్ట ్చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

267. To stop video time at 08 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know how to use animated image? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని animated image option ని ఎలా 

ఉపయోగించాలో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

268. To stop video time at 8 minute 40 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 08 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Insert’ menu and then click 

‘Animated image’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Insert menu’ ని కి లక్ట చేసి తర్థవాత ‘Animated image’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

269. To stop video time at 9 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert the picture and then click on the 

‘apply object’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

పకి్ ర్ట ని ఇనస ర్ట ్చేసి తర్థవాత ‘apply object’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

270. To stop video time at 9 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and the play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

271. To stop video time at 10 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 18 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and the play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

272. To stop video time at 12 minute 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have made animated image or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు animated image ని తయార్థ చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

273. To stop video time at 12 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they know how to use ‘Size and Position’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Size and Position’ option ని ఎలా 

ఉపయోగించాలో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

 

 

274. To stop video time at 12 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide as shown in the video and 

then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ కొత ాslide ని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

275. To stop video time at 13 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ object ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

276. To stop video time at 13 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Size and Position’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని ‘Format menu’ని  కి లక్ట చేయమనండి. 

తర్థవాత ‘Size and Position’ option  ని కి లక్ట చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

277. To stop video time at 14 minute 23 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 23 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Size and Position’ option or not and 

then play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Size and Position’ option ని ఉపయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

278. To stop video time at 14 minute 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to draw a picture using line ‘Tool line’ and 

also change the formatted line and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Tool line’ option ని ఉపయోగించి 

఑క్ లైన్ ని  గీయమనండి.మరియు format అయిన లైన్ ని కూడా 

మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

279. To stop video time at 15 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw as shown in the video and then play 

the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

280. To stop video time at 15 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 15 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Line’ option as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని  కి లక్ట చేయమనండి. తర్థవాత ‘Line’ option  ని కి లక్ట 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

281. To stop video time at 16 minute 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

282. To stop video time at 17 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 10 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have formatted the line or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు లైన్ ని format చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

283. To stop video time at 17 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they know how to use ‘Area’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Area’ option ని ఎలా 

ఉపయోగించాలో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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284. To stop video time at 18 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide and then draw an object 

and then play the video again.  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ కొత ాslide ని ఇనస ర్ట ్చేసి 

తర్థవాత ఑క్ object ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

285. To stop video time at 18 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Area’ option as shown in the video and then play the video again. 

 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని కి లక్ట చేసి, తర్థవాత ‘Area’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

286. To stop video time at 19 minute 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

287. To stop video time at 20 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used ‘Area’ option or not and then play the 

video again. 
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ఇప్పప డు విద్యా ర్థులు ‘Area’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

288. To stop video time at 20 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to type the given spelling as shown in the 

video and also tell how to check the spelling then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఇచిి న spelling ని టైప్ చేయమనండి. మరియు spelling ని ఎలా చెక్ట 

చేయాలి ? అని అడగండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

289. To stop video time at 21 minute 53 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 53 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to type the given words as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఇచిి న పద్యలని టైప్ చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

290. To stop video time at 23 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to correct the wrong spelling as shown in the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

తప్పప  spelling ని క్రక్ట ్చేయమనండి.  
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Now just check whether they have corrected the spelling or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు spelling ని క్రక్ట ్ చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 
291. To stop video time at 23 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to insert any picture and then use the color 

replacer option to replace the color of the picture and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఏదైన్న పక్ి ర్ట ని ఇనస ర్ట ్చేసి, 

తర్థవాత పకి్ ర్ట color ని replace చేయటానికి color replacer option ని 

ఉపయోగించమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

292. To stop video time at 24 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a new slide and then insert a picture 

as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఑క్ కొత ాslide ని ఇనస ర్ట ్చేసి 

తర్థవాత ఑క్ పకి్ ర్ట ని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

293. To stop video time at 24 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

294. To stop video time at 25 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have replaced the color or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు color ని replace చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

295. To stop video time at 25 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to insert any file/object on the sheet and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని sheet లో ఏదైన్న file/object ని 

ఇనస ర్ట ్ చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

296. To stop video time at 26 minute 17 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 17 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to click on the ‘Object’ option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

తర్థవాత ‘Object’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

297. To stop video time at 27 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have inserted the file or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు file ని ఇనస ర్ట ్చేశారొ  లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

298. To stop video time at 28 minute 05 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 05 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know what happens with ‘Minimize 

presentation’ and why we use it? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Minimize presentation’ option ని 

ఉపయోగిస్త ాఏమి జర్థగుతుందో, మనము ద్యనిని ఎందుకు ఉపయోగిసాామో 

వాళ్ు  కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

299. To stop video time at 28 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

the ‘Minimize presentation’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Tools menu’ ని కి లక్ట చేసి, తర్థవాత 

‘Minimize presentation’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

300. To stop video time at 29 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

301. To stop video time at 30 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have done the use of ‘Minimize presentation’ or 

not and then play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Minimize presentation’ option ని ఉపయోగించటం 

ప్యరి ాచేశారొ లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

302. To stop video time at 30 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office Impress 2 Class 9 

Impress 2 Class 9 యొక్క పూర్తి టీచర్ manual. 
Summaries 

Class 9 సార్ాాంశాం 

 Why we use ‘Extension manager’? 

 మనము‘Extension manager’ ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Auto correct’ option? 

 మనము‘Auto correct’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Customize’ option’? 

 మనము‘Customize’ option’ ని ఎందుకు ఉపయోగిస్తా ము?  
 How to select any ‘Menu’? 

 ఏద ైనా‘Menu’ ని ఎలా స్ెలెక్్ట చేయాలి?  
 How to design the slide? 

 Slide ని ఎలా design చేయాలి? 

 Why we use ‘Option’?  

 మనము‘Option’ ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Interaction’? 

 మనము‘Interaction’ ని ఎందుకు ఉపయోగిస్తా ము?  
 How to apply effects on slide? 

 Slide లో effects ని ఎలా అపెలై  చేయాలి? 

 Why we use Custom animation? 

 మనము Custom animation ని ఎందుకు ఉపయోగిస్తా ము? 

 Why we use slide transition? 

 మనము slide transition ని ఎందుకు ఉపయోగిస్తా ము?  
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 Why we use ‘Custom slide show’? 

 మనము‘Custom slide show’ ని ఎందుకు ఉపయోగిస్తా ము?  
Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
303. To stop video time at 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 34 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they can tell what they learnt in previous class? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఇంతకు ముందు కాలస్ లో ఏమి 

ర్చర్థి కున్ని రొ వాళ్ళు  చెపప గలరా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

304. To stop video time at 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 40 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask, if they know what can we change using ‘Area option’? 
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ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని ‘Area option’ ని ఉపయోగించి 

మనము ఏమి మారి గలమో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 
305. To stop video time at 1 minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 03 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask what can we change using ‘Line option’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Line option’ ని ఉపయోగించి 

మనము ఏమి మారి గలము ?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

306. To stop video time at 1 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask, in which Menu ‘Animated image’ can be found and 

why we use it? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఏ menu లో  ‘Animated image’ 

option’ ని క్నుగంటాము మరియు మనము ద్యనిని ఎందుకు 

ఉపయోగిసాాము?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

307. To stop video time at 2 minute 10 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాం 10 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why use ‘Text’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Text’ option ని ఎందుకు 

ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

308. To stop video time at 2 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Crop picture’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Crop picture’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

309. To stop video time at 2 minute 53 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 53 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Impress fileని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

310. To stop video time at 3 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and check whether they have opened ‘Impress file’ or not ? 

ఇప్పప డు విద్యా ర్థులు ‘Impress file’ ని open చేశారొ లేదో చెక్ట చేయండి.  

Now just check and then play the video again 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

311. To stop video time at 4 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to insert four slides and type the given line on 

the 1
st
 slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని న్నలుగు slide లని ఇనస ర్ట ్ చేసి 

ఇచిి న లైన్ ని మొద్టి slide లో టైప్ చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 
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312. To stop video time at 4 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to draw any shape on the second slide and also 

ask to type a line about those Shapes and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని రండవ slide లో ఏదైన్న shape ని 

గీయమనండి .మరియు ఆ shape గురించి ఑క్ లైన్ ని కూడా టైప్ 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

313. To stop video time at 5 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a picture as shown in the video and 

then play video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ పకి్ ర్ట ని  ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

314. To stop video time at 6 minute 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the design of the slide as shown in 

the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide design ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

315. To stop video time at 7 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the design again as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide design ని మర౉క్సారి మారి మనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

316. To stop video time at 7 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and tell students if they know what work can do with help of 

the ‘Extension manager’ and how to use it? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Extension manager’ option 

సహాయంతో ఏ పని చేయవచ్చి  మరియు ద్యనిని ఎలా ఉపయోగించాలో 

వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

317. To stop video time at 9 minute 00 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 09 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Extension manager’ as shown in the video and then play the video again. 

 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేయమనండి.తర్థవాత ‘Extension manager’ option  

ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

318. To stop video time at 10 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to download any extension as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న extension ని download చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

Note: - internet connection is required to download any contents. 

నోట్:- ఏవ ైనా content లని download చేయటానికర internet connection అవసరం. 
319. To stop video time at 10 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to add the ‘Extension’ as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Extension’ ని add చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 
 

320. To stop video time at 10 minute 59 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to open the Extension which they had 

downloaded as shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

వాళ్ళు  download చేసిన Extension ని open చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

321. To stop video time at 12 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to open impress file and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Impress fileని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

322. To stop video time at 13 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to check the extension which they had 

installed and play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ళు  install చేసిన extension ని 

చెక్ట చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

Now just check and then play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 
 

 

 

 

 

 

 

323. To stop video time at 13 minute 15 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 15 సెక్న్ల  వద్ద  ఆపాండ.ి 



   

179 
 

 
Stop video here and ask if they can tell why we use ‘Auto correct’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Auto correct’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

324. To stop video time at 14 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Auto correct’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేయమనండి. తర్థవాత ‘Auto correct’ option  ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

325. To stop video time at 14 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

326. To stop video time at 15 minute 39 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 15 నిమషాల 39 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

327. To stop video time at 17 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have used the ‘Auto correct option or not and then 

play the video again. 

 ఇప్పప డు విద్యా ర్థులు Auto correct option ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

328. To stop video time at 17 minute 12 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 12 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask them, if they know why we use ‘Customize’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Customize’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 
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329. To stop video time at 19 minute 17 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 17 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to remove ‘Hyperlink’ and ‘Object’ option 

from ‘Edit menu’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Edit menu’ నుంచి ‘Hyperlink’ మరియు ‘Object’ option ని 

తొలగించమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

330. To stop video time at 19 minute 34 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 34 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

the ‘customize’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Tools menu’  ని కి లక్ట చేసి తర్థవాత 

‘customize’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

331. To stop video time at 21 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to create the menu as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

menu ని create చేయమనండి.  

Now just check whether they have created the menu or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు menu ని create చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 



   

182 
 

 

 

 

332. To stop video time at 21 minute 51 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 021 నిమషాల 51 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they know why ‘Option’ option is used? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Option’ option ని ఎందుకు 

ఉపయోగిసాారొ వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

333. To stop video time at 22 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Option’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేసి తర్థవాత ‘Option’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

334. To stop video time at 23 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 



   

183 
 

Stop video here and ask students to change the view of impress file as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

impress file view ని మారి మనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

335. To stop video time at 23 minute 20 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the normal view as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

impress file ని normal view లోకి మారి మనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

336. To stop video time at 24 minute 58 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 58 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

337. To stop video time at 25 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

color name  ని సవ ంతగా create చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

338. To stop video time at 26 minute 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

339. To stop video time at 26 minute 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 43  సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

340. To stop video time at 27 minute 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 27 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to edit the ‘Grid’ option as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Grid’ option ని edit చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

341. To stop video time at 28 minute 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 28 నిమషాల 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

342. To stop video time at 28 minute 56 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 28 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have used the ‘Option’ option and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Option’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

343. To stop video time at 29 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 29 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Interaction’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Interaction’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

344. To stop video time at 30 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to type any word on the title box as shown in 

the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

title box  లో ఏదైన్న పద్యనిి  టైప్ చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

345. To stop video time at 30 minute 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 08   సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to click on the ‘Slide Show’ and then click on 

‘Interaction’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Slide Show’ ని కి లక్ట చేసి,తర్థవాత ‘Interaction’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

346. To stop video time at 30 minute 47 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 30 నిమషాల 47 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video and then play the 

video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

347. To stop video time at 32 minute 23 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 32 నిమషాల 23 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to attach any document in title slide as shown 

in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

title slide లో ఏదైన్న document ని attach చేయమనండి.  

 

Now just check and then play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

348. To stop video time at 32 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 32 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Slide transition’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Slide transition’ option 

ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

349. To stop video time at 33 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Slide Show’ and then click on 

‘Slide transition’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Slide Show’ ని కి లక్ట చేసి, తర్థవాత ‘Slide transition’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

350. To stop video time at 33 minute 57 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 33 నిమషాల 57 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the effects on slides as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slides లో effects ని అప్ల ల చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

351. To stop video time at 34 minute 40 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 34 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have applied ‘Slide transition’ or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Slide transition’ ని అప్ల ల చేశారొ  లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

352. To stop video time at 34 minute 46 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 34 నిమషాల 46 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Custom animation’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Custom animation’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

353. To stop video time at 35 minute 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to draw a smiley face as shown in the video 

and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

నవువ తుని  మొహానిి  గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

354. To stop video time at 35 minute 59 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 35 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ object ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

355. To stop video time at 36 minute 16 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 36 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ object ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

356. To stop video time at 37 minute 17 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 37 నిమషాల 17 సెక్న్ల  వద్ద  ఆపాండి. 
Stop video here and ask students to customize the slides as shown in the video 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slides ని customize చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

357. To stop video time at 37 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 37 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to show slide show as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide show ని చూపంచమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

358. To stop video time at 38 minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have customized the slides or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు slide లని customize చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

359. To stop video time at 38 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 38 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office impress 2 Class 10 

Impress 2 Class 10 యొక్క పూర్తి టీచర్ manual. 
Class 10 Summaries 

Class 10 సార్ాాంశాం 

 How to record a data, picture and drawing in impress file? 

 impress file లో data, picture మరి్యు drawing ని ఎలా record చేయాలి?  
 Why we use extension manager ? 

 మనము extension manager ని ఎందుకు ఉపయోగిస్తా ము?  
 How to use auto correct option ? 

 auto correct option ని ఎలా ఉపయోగించాలి? 

 What is rehearse timing ? 

 rehearse timing అంటే ఏమిట?ి 

 Why we use interaction ? 

 మనము interaction ని ఎందుకు ఉపయోగిస్తా ము?  
 How to use slide transition ? 

 slide transition ని ఎలా ఉపయోగించాలి? 

 Why we use custom slide show ? 

 

Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
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360. To stop video time at 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 సెక్న్ల  వద్ద  ఆపాండి. 
 

 
Stop video here and ask if they can tell why we use spelling? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము spelling option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి.  

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

361. To stop video time at 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 48 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they know why we ‘Custom Animation’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Custom Animation’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 
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జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

362. To stop video time at 1 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 18 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they know what happens with ‘Customize’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Customize’ option ని ఊపయోగిస్త ా

ఏమి జర్థగుతుందో వాళ్ు  కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

363. To stop video time at 1 minute 50 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 50 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know why we use ‘Rehearse timing’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Rehearse timing’ option 

ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

364. To stop video time at 2 minute 08 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాం 08 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask if they know why we use interaction? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము interaction option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

365. To stop video time at 2 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask if they know what is custom slide show? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని custom slide show అంటే ఏమిటో 

వాళ్ు కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

366. To stop video time at 2 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to turn on their computer and open ‘Impress 

file’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని Impress file ని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

367. To stop video time at 2 minute 59 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 02 నిమషాల 59 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and check whether they have opened the impress file or not and 

then play the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులు Impress fileని open చేశారొ లేదో చెక్ట 

చేయండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

368. To stop video time at 3 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to insert 5 new slides and type this paragraph 

about ‘Computer Shiksha’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఐదు కొత ాslide లని ఇనస ర్ట ్ చేసి 

‘Computer Shiksha’ గురించిన ఈ ప్లరాని టైప్ చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

369. To stop video time at 3 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert picture and do formatting on this 

picture, after that they should practice ‘Custom animation’ option and then play 

the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని పకి్ ర్ట ని ఇనస ర్ట ్ చేసి ఈ పకి్ ర్ట 

లో formatting చేయమనండి .తర్థవాత ‘Custom animation’ option  ని 

practice చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

370. To stop video time at 4 minute 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert slides and draw shape using drawing 

toolbar as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slides ని ఇనస ర్ట ్చేయమనండి .మరియు drawing toolbar ని ఉపయోగించి 

shape ని గీయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

371. To stop video time at 5 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the formatting of the image and give 

the title for this picture as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

image formatting ని మారి మనండి.మరియు ఈ పకి్ ర్ట కి title ని 

ఇవవ మనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

372. To stop video time at 6 minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an image and do the formatting of the 

image as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ image ని గీసి image ని formatting చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

373. To stop video time at 6 minute 36 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 06 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert a picture from insert option shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

insert option నుంచి ఑క్ పకి్ ర్ట ని ఇనస ర్ట ్చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

374. To stop video time at 7 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 07 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw an image and do the formatting of the 

image as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

఑క్ image ని గీసి image ని formatting చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి 

 

375. To stop video time at 8 minute 13 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 08 నిమషాల 13 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the ‘slide design’ as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘slide design’ ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

376. To stop video time at 9 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

377. To stop video time at 10 minute 54 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 10 నిమషాల 54 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to use ‘custom animation’ and then show the 

slide show as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని‘custom animation’ option ని 

ఉపయోగించమనండి.ఆ తర్థవాత వీడియోలో చూపంచిన విధముగా slide 

show ని చూపంచమనండి.  

Now just check whether they have used ‘Custom animation’ or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Custom animation’ option ని ఉపయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

 

378. To stop video time at 11 minute 04 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 04 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to open another file using ‘Interaction’ option 

and then play the video again. 



   

200 
 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Interaction’ option ని 

ఉపయోగించి మర౉క్ file ని open చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

379. To stop video time at 11 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Slide show’ and then click on 

‘Interaction’ option as shown in the video and then play the video again. 
ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Slide show’ ని కి లక్ట చేయమనండి.తర్థవాత ‘Interaction’ option  ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

380. To stop video time at 12minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 03 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to attach the file as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

file ని attach చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

381. To stop video time at 12 minute 49 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 12 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to use ‘Interaction’ option as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Interaction’ option ని ఉపయోగించమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

Now just check whether they have used ‘Interaction’ option or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ‘Interaction’ option ని ఉపయోగించారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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382. To stop video time at 13 minute 01 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 01 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to use the ‘Custom animation’ and then play 

the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Custom animation’ option ని ఉపయోగించమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

383. To stop video time at 13 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to select the paragraph and then click on the 

‘Slide show’ menu and then click on the ‘Custom animation’ option as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ప్లరాని సెలెక్ట ్చేసుకొని తర్థవాత ‘Slide show’  పైన కి లక్ట చేసి ఆ తర్థవాత 

‘Custom animation’ option ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

384. To stop video time at 13 minute 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

Stop video here and ask students to apply the custom animation as shown in the 

video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

custom animation ని అప్ల ల చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

385. To stop video time at 16 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the practice of ‘Custom animation’ on 

every slide as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని  వీడియోలో చూపంచిన విధముగా 

ప్పతి  slide లో ‘Custom animation’ ని practice చేయమనండి.  

 

Now just check whether they have practiced ‘custom animation’ option or not 

and play the video again for correct answer. 

ఇప్పప డు విద్యా ర్థులు ‘custom animation’ option ని practice చేశారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

 

386. To stop video time at 16 minute 09 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 09 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to do practice of ‘Rehearse timing’ and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Rehearse timing’ option ని 

practice చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి.  

 

387. To stop video time at 18 minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 03 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply ‘Rehearse timing’ as shown in the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Rehearse timing’ ని అప్ల ల చేయమనండి.  

Now just check whether they have used ‘Rehearse timing’ option or not and 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Rehearse timing’ option ని ఉపయోగించారొ లేదో 

చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

 

388. To stop video time at 18 minute 16 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 18 నిమషాల 16 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to do practice of ‘Style and formatting option’ 

as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Style and formatting option’ ని practice చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

389. To stop video time at 18 minute 44 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 44 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Style and Formatting’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Format menu’ ని కి లక్ట చేసి,తర్థవాత ‘Style and Formatting’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

390. To stop video time at 19minute 14 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 14 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the background color as shown in 

the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

background color  ని మారి మనండి.  

 

Now just check whether they have practiced ‘Styles and formatting’ option or 

not and play the video again for correct answer. 
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ఇప్పప డు విద్యా ర్థులు ‘Styles and formatting’ option  ని practice చేశారొ  

లేదో చెక్ట చేసి తర్థవాత సరైన సమాధానం కోసం వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

391. To stop video time at 19 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to do the practice of ‘Slide Transition’ on 

every slide as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ప్పతి slide లో ‘Slide Transition’  ని practice చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

392. To stop video time at 21 minute 07 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 07 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి. 

Now just check whether they have practiced ‘Slide Transition’ option or not and 

play the video again for correct answer. 

ఇప్పప డు విద్యా ర్థులు ‘Slide Transition’ option ని practice చేశారొ  లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 
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393. To stop video time at 21 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to give the effects using ‘slide transition’ and 

show slide show as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘slide transition’ option ని ఉపయోగించి effect లని ఇవవ మనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

394. To stop video time at 22 minute 49seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 49 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the animation on the text and 

animation as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

text లో animation ని అప్ల ల చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

395. To stop video time at 25 minute 12 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 25 నిమషాల 12 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the timing on each text and object as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ప్పతి text మరియు object లో timing ని అప్ల ల చేయమనండి.తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 
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396. To stop video time at 26 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to play the slide show as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide show ని ప్లల చేయమనండి.  

Now just check whether they have used ‘slide transition’ option or not and play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘slide transition’ option ని ఉపయోగించారొ లేదో చెక్ట 

చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

397. To stop video time at 26 minute 35 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 26 నిమషాల 35 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 
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Complete teacher’s manual for Open office Impress 2 Class 11 

Impress 2 Class 11 యొక్క పూర్తి టీచర్ manual. 
Class 11 Summaries 

Class 11 సార్ాాంశాం 

 Why we use ‘Interaction’? 

 మనము ‘Interaction’ ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Custom animation’ option? 

 మనము ‘Custom animation’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 Why we use ‘Color replacer’ option’? 

 మనము ‘Color replacer’ option ని ఎందుకు ఉపయోగిస్తా ము? 

 How to do any ‘Formatting on drawing? 

 Drawing లో ఏద ైనా formatting ని ఎలా చేయాలి? 

 How to insert a new slide? 

 కొతా్ slide ని ఎలా ఇనసర్్ట చేయాలి? 

 How to use slides into ‘Summary slide’?  

 Slide లని ‘Summary slide’ గత ఎలా ఉపయోగించాలి?  
 Why we use ‘Expand slide’? 

 మనము‘Expand slide’ option ని ఎందుకు ఉపయోగిస్తా ము?  
 What happens by ‘Properties’ option? 

 ‘Properties’ option ని ఉపయోగిస్తా  ఏమి జరుగుత్ ంద?ి 

 What happens by ‘Hyperlink’ option? 

 ‘Hyperlink’ option ని ఉపయోగిస్తా  ఏమి జరుగుత్ ంద?ి 

 Why we use ‘Slide transition’? 

 మనము‘Slide transition’ option ని ఎందుకు ఉపయోగిస్తా ము?  
Now let’s start the video. 

ఇపపుడు వీడియోని మొదలుపెడదాము. 
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398. To stop video time at 39 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 39 సెక్న్ల  వద్ద  ఆపాండి. 

 
Stop video here and ask if they can tell why we use ‘Interaction’ option’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Interaction’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

399. To stop video time at 1 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 02 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they know why we use ‘Slide transition’ option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Slide transition’ option 

ని ఎందుకు ఉపయోగిసాామో వాళ్ు కి తెలుసా?అని అడగండి. 
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Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

 

400. To stop video time at 1 minute 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 01 నిమషాం 36 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Minimize presentation’ 

option? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Minimize presentation’ 

option ని ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

401. To stop video time at 2 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాం 02 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask if they can tell why we use ‘Slide design’ option? 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని మనము ‘Slide design’ option ని 

ఎందుకు ఉపయోగిసాామో వాళ్ళు  చెపప గలరా?అని అడగండి. 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

402. To stop video time at 2 minute 21 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 02 నిమషాల 21 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని Impress file ని open చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

403. To stop video time at 3 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 3 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండి. 
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Stop video here and ask students to insert four slides and also to change design 

of each slide and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని న్నలుగు slide లు ఇనస ర్ట ్చేసి ప్పతి 

slide design ని మారి మనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

404. To stop video time at 3 minute 36 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 03 నిమషాల 36 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to type about ‘Computer Shiksha’ or ‘their 

own School’ and also to do formatting on the paragraph as explained in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి,విద్యా ర్థులని వీడియోలో వివరించిన విధముగా  

‘Computer Shiksha’ గురించి లేక్ వాళ్ు  స్కక ల్ గురించి టైప్ 

చేయమనండి.మరియు ప్లరాలో formatting చేయమనండి. తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

405. To stop video time at 4 minute 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 04 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the design of the slide as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide design ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

 

 

406. To stop video time at 5 minute 41 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 05 నిమషాల 41 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to change the design of all slides as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

అనిి  slide ల design ని మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

 

407. To stop video time at 6 minute 22 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 22 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do the formatting on the text as shown in the 

video.  

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

text లో formatting చేయమనండి. 
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Now just check whether they have done all these formatting or not and play the 

video again. 

ఇప్పప డు విద్యా ర్థులు ఈ formatting ని అంతా చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

408. To stop video time at 6 minute 30 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 30 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and check whether they have completed the task or not and then 

play the video again. 

 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులు వాళ్ు కి ఇచిి న పనిని ప్యరి ాచేశారొ 

లేదో చెక్ట చేసి తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

409. To stop video time at 6 minute 40 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 06 నిమషాల 40 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to apply animation on the objects and text and 

then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని object  లు మరియు text లో 

animation ని అప్ల ల చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

410. To stop video time at 9 minute 00 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 00 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw some object and pictures on different 

slides as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా  

వేర్థ వేర్థ slide లలో కొనిి  object లు మరియు పకి్ ర లని గీయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

411. To stop video time at 9 minute 43 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 09 నిమషాల 43 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the custom animation as shown in the 

video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

custom animation ని అప్ల ల చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి 

 ప్లల చేయండి. 

 

412. To stop video time at 11 minute 24 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 24 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply the animation as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

animation ని అప్ల ల చేయమనండి.  

 

Now just check whether they have applied ‘Custom animation’ or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Custom animation’ ని అప్ల ల చేశారొ  లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

413. To stop video time at 11 minute 45 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 11 నిమషాల 45 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to insert any picture and change the 

background using the ‘Color replacer and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ఏదైన్న పకి్ ర్ట ని ఇనస ర్ట ్చేసి 

‘Color replacer’ option ని ఉపయోగించి background ని మారి మనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

414. To stop video time at 13 minute 11 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 11 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to draw objects and also do the formatting as 

shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

object లని గీసి formatting ని కూడా చేయమనండి. తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

415. To stop video time at 13 minute 25 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 13 నిమషాల 25 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Tools menu’ ని కి లక్ట చేసి,తర్థవాత ‘Color replacer’ option ని కి లక్ట 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

416. To stop video time at 14 minute 18 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 18 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students to replace the background color of the picture 

as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

పకి్ ర్ట background color  ని replace చేయమనండి.  

 

Now just check whether they have replaced the background color or not and 

then play the video again. 

ఇప్పప డు విద్యా ర్థులు background color ని replace చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

417. To stop video time at 14minute 26 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 26 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to do practice of ‘Slide transition’ and then 

play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Slide transition’ ని practice 

చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

418. To stop video time at 14 minute 48 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 14 నిమషాల 48 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Slide show and then click on 

the ‘Slide transition’ and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Slide show ని కి లక్ట చేసి,తర్థవాత 

Slide transition’ ని కి లక్ట చేయమనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

419. To stop video time at 15 minute 52 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 15 నిమషాల 52 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to apply effects and sound effects as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

effects మరియు sound effects ని అప్ల ల చేయమనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

 

420. To stop video time at 16 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do slide show as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

slide show చేయమనండి.  

 

Now just check whether they have applied the ‘Slide transition or not and then 

play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Slide transition’ ని అప్ల ల చేశారొ  లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

421. To stop video time at 16 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 16 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
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Stop video here and ask students if they know what happens with ‘Summary 

slide’? 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని ‘Summary slide’ option ని 

ఊపయోగిస్త ాఏమి జర్థగుతుందో వాళ్ు  కి తెలుసా?అని అడగండి. 

 

Just listen to the answers and play the video again for the correct answer. 

జవాబులని వినండి మరియు సరైన జవాబు కోసం వీడియోని మర౉క్సారి 

play చేయండి. 

422. To stop video time at 17 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to type some title as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

ఏదైన్న title ని టైప్ చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

423. To stop video time at 17 minute 56 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 17 నిమషాల 56 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to create the Summary slide as shown in the 

video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

Summary slide ని create చేయమనండి.  

Now just check whether they have created the summary slide or not and then 

play the video again. 
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ఇప్పప డు విద్యా ర్థులు summary slide ని create చేశారొ  లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

424. To stop video time at 18 minute 03 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 03 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
Stop video here and ask students to convert ‘Summary slide into ‘Title slide’ 

and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని Summary slide ని ‘Title slide’ గా 

మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

425. To stop video time at 18 minute 33 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 18 నిమషాల 33 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check and then play the video again. 

ఇప్పప డు ఑క్సారి చెక్ట చేసి వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

 

 

 

 

 

 

426. To stop video time at 18 minute 57 seconds in VLC Media Player. 
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వీడియో ని VLC Media Player లో 18 నిమషాల 57 సెక్న్ల  వద్ద  ఆపాండ.ి 
 

 
Stop video here and ask students to insert one more slide and in this slide ask 

them to attach any file on it as shown in video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

మర౉క్ slide ని ఇనస ర్ట ్చేసి ఈ slide లో ఏదైన్న file ని attach చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

427. To stop video time at 19 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 19 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘Hyperlink’ option as shown in 

the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Hyperlink’ option ని కి లక్ట చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 

428. To stop video time at 20 minute 55 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 20 నిమషాల 55 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to insert hyperlink as shown in the video and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘Hyperlink’ ని ఇనస ర్ట ్చేయమనండి. తర్థవాత వీడియోని మర౉క్సారి ప్లల 

చేయండి. 
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429. To stop video time at 21 minute 27 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 27 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they have inserted the ‘Hyperlink’ or not and then play 

the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Hyperlink’ ని ఇనస ర్ట ్చేశారొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

430. To stop video time at 21 minute 37 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 21 నిమషాల 37 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to convert their file into ‘MS Power point’ and 

then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని ‘MS Power point’ లోకి 

మారి మనండి.తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

431. To stop video time at 22 minute 02 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 22 నిమషాల 02 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to click on the ‘File menu’ and then click on 

‘Wizard’ as shown in the video and then play the video again. 
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ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

‘File menu’ ని కి లక్ట చేసి,తర్థవాత ‘Wizard’ option ని కి లక్ట చేయమనండి. 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

432. To stop video time at 23 minute 19 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 19 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

 

Now just check whether they converted the document or not and then play the 

video again. 

ఇప్పప డు విద్యా ర్థులు document ని మారాి రొ లేదో చెక్ట చేసి తర్థవాత 

వీడియోని మర౉క్సారి ప్లల చేయండి. 

 

433. To stop video time at 23 minute 28 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 23 నిమషాల 28 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to tell all information about the file as shown 

in the video and then play the video again. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

file గురించిన సమాచారాని ంతా చెపప మనండి.తర్థవాత వీడియోని 

మర౉క్సారి ప్లల చేయండి. 

434. To stop video time at 24 minute 20 seconds in VLC Media Player 



   

224 
 

వీడియో ని VLC Media Player లో 24 నిమషాల 20 సెక్న్ల  వద్ద  ఆపాండ.ి 
Stop video here and ask students to do as shown in the video. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వీడియోలో చూపంచిన విధముగా 

చేయమనండి.  

Now just check whether they have practiced the ‘Property’ option or not and 

then play the video again. 

ఇప్పప డు విద్యా ర్థులు ‘Property’ option ని practice చేశారొ లేదో చెక్ట చేసి 

తర్థవాత వీడియోని మర౉క్సారి ప్లల చేయండి. 

435. To stop video time at 24 minute 32 seconds in VLC Media Player. 

వీడియో ని VLC Media Player లో 24 నిమషాల 32 సెక్న్ల  వద్ద  ఆపాండ.ి 

 
 

Stop video here and ask students to close their file and shut down the computer. 

ఇక్క డ వీడియోని ఆపండి, విద్యా ర్థులని వాళ్ు  file ని close చేసి క్ంప్యా టర్ట 

ని shutdown  చేయమనండి. 

 

 


